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1) GOALS

Ly Mefracions,

After completing this walkthrough, you will have:
¢ Installed uDig from the Windows installer.

e Learned the basic uDig functionality.
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2) INSTALLING AND RUNNING THE UDIG APPLICATION

In this section, you will install and run the Eclipse Application, which will be used
for viewing map information.

Windows install:

1. Double-click the installer udigl.0.5.exe (located in the same directory as this
walkthrough).

% Flease wait while Setup is loading. ..
verifying installer: 67%%

2. The installer will allow you to install uDig into the directory of your choice.
% ubig 1.0.5 Setup A=l

Welcome to the uDig 1.0.5 Setup
Wizard

Thig wizard will guide you through the installation of UDig
Mote that this is the first attempt by the uDig project to
create a Windows executable installer. Please report any
problems or suggestions for improvement to

udig-devel@lists.refractions.net.

Click Mext to continue,

[oext> | [ Cancel ]

oree to the License A
B ubig 1.0.5 Setup

reement — uDig

is made available under the LGPL.

10X

License Agreement
Please review the license terms before installing ulig 1.0.5. %

Press Page Down to s2e the rest of the agresment.

GNU Lesser General Public License ~
ersion 2.1, February 1999

Copyright () 1991, 1992 Free Software Foundation, Inc. 52 Temple Place, Suite 330,
Boston, MA& 02111-1307 USA Everyone is permitted to copy and distribute verbatim

copies of this license document, but changing it is not allowed.

[This is the first released version of the Lesser GPL. It also counts as the successor of
the GMU Library Public License, version 2, hence the version number 2.1.]

If you accept the terms of the agreement, dick I Agree to continue, You must accept the
agreement to install ubig 1.0.5.

<Back || IAgree | [ Cancel
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Ly Mefracions,

By default uDig will be installed into your Program Files directory.
% uDig 1.0.5 Setup

Choose Install Location
Choose the folder in which to install uDig 1.0.5. %

Setup will install uDig 1.0.5 in the following folder. To install in a different folder, dick Browse
and select anather folder, Click Next to continue,

Destination Folder
C:\Program Files\uDigh1.0. 51 | Browse. ..

Space required: 100.9MB
Space available: 56.6GE

< Back ” Mext = l [ Cancel

Shortcuts will be created in your start menu
% uDig 1.0.5 Setup [

Choose Start Menu Folder
Choose a Start Menu folder for the ulig 1.0.5 shorteuts, %

Select the Start Menu falder in which you would like to create the program's shortcuts. You
can also enter a name to create a new folder,

Accessories

activepdf
Administrative Tools
Adobe

Brother HL-1850_1870M
Debugmode

Games

GeoServer 1,3.0-RC3
iTunes

jEdit 4.2

Micrasaft AntiSpyware

oo not create shortouts

[

I3

< Back ” Install l ’ Cancel
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6. After completing the installation, run the uDig application from the Windows
Start->Programs menu

UDig

User-friendly Desktop Internet GIS

We woLld like to acknowileddge the fin

7. Click on the Workbench arrow in the top right corner of the uDig welcome
screen to open the uDig workbench area.

% User-friendly Desktop Internet GIS |Z|[E||Z|
Eile Layer Analysis Window Help
=+
Welcome to uDig Q{y
e |
2>
N\
BUILT ON
== 0 el
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3) ONLINE DOCUMENTATION AND TUTORIALS

In this section you will open up the online tutorial, and access reference

information.

Online Tutorials

1) You can access an online tutorial directly from the Welcome screen:

- :..
[

Getting Started ) =
Access the Introductory tutorial. @ i Z | W

5 Help - UDIG

Search: Search scope: All topics
Contents [ |

Thiz tutorial provides a step by stey
“Workbench.

@ uDig User Guide

s The Worlibench
s Editors and views

o Editors

2) This will bring up the online help system; the help system is a web
application that makes use of a Contents view to allow you to navigate
between Pages.

““/Refresh / Show Current Topic
Can be used to find your place in the table of contents

EY Show in Table of Contents
Can be used to find your place in the table of contents

You can also access online help at any time from the Help menu:

Welcome
8@ Help Contents

Find and Install...

About UDIG

You can access additional reference information in the following categories:

@ uDig User Guide
B8 Cetting Started
(A Concepts

[ Tasks

(A Reference

A Fag

[ﬂ] uDig User Guide
[ Getting Started
BE Concepts
[ Tasks
[ Reference
[AFag

[‘i] uDig User Guide

[ Getting Started

[ Cancepts
Tasks

[0 peference

[AFag

[ﬂ] uDig User Guide
[ Getting Started
[ Concepts

[ tasks

@ Ref rla!_rltiin:rp,tsL
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Thiz section contains tutorials that will help users to familiarize
themselves with TDIG and tts user interface.

At this time there 15 one tutonial available:

High-Level description of ideas, architecture. Provides
background information to understand what is going on.

® Related concepts

Task descriptions are step by step mstructions for performing
spectfic actions and tasks in the Workbench. For example, the
Tasks section contains step by step instnictions for connecting to
a Web Map Server, and for adding a layer mto a 2Map.

@ Related tasks

@ Related reference

o Views and editors
o Mlenus

o Toolbars
a Preferences



4) CONNECTING TO A WEB MAP SERVER

In this section you will learn how to drag and drop a Web Map Server (WMS) link

into uDig for the purpose of viewing its layers.

3) There are many ways to load map data into uDig, including drag and drop.
To drag a Web Map Server (WMS) link into uDig, open up a web browser.

4) Please connect to the Walkthrough 1 page with Firefox:
http:/ /udig.refractions.net/confluence/display/UDIG/Walkthrough+1

5) Click and drag the DM Solutions WMS from the web page onto the Layers

View on the left, and drop it there.

it

[#- g My Projects
3 Layers &1 =

3 Walkthrough 1 - Userfriendly Desktop Internet GIS - Mozill
Fle Edt ‘Wew Go PBodmarks Tods Help
G- OG0 S l% hiktkp ffudig. refractions. netfconflue

(1 ecipse ] artides () office |3 GT2 |J G5 [ uDig ) email |7«

2 Homi
Cazhboard = ulig = Documentation = Walkthrough 1 = View
This walkthrough is available as a pdf file:

* ubig install and inbro . pdf

T% E@Ir{thnu gh includes references to the fallowing servers:

WS IPL World Map Servica®

WFS  Exarmple wEs®
WFS DM Solutions WFE®

o) 2005 Refractions Research

bikbp: e dmsolutions . calegi-bindmswims _gmap?Service=YWM S8 ER SI0N=1.

Figure 1 Drag and Drop WMS link into uDig

Tip: If working with your windows maximized: 1) Drag from the web browser 2) Hover on
the uDig application in the windows taskbar 3) Drop into the Map area.
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6) The Add Layers a wizard will appear asking you what layers from this WMS
you want to show in your map. Select bathymetry, park, popplace and
Finish.

= addLayers to Map E

Layer Selection + =
Select resources that the new map will be composed Fram. %E

"
O & drain_fn
O & drainage
O & prov_bound
O & fedimit

O & rail

O & road
popplace
O& od

< Back | | Einish | Cancel

Figure 2 Add Layers Window

8. The map layers will now render in the Map view. Notice the bottom right
corner of the uDig Application will display a processing notice while it is
requesting and drawing the layers.

File Edit Mavigation Laver Tools Analysis Window Help
| = @ | = |3 E e P B R T

|12 Projects 52 b=l a1 X = 1|

B Q:, My Projects
=118 project
+ [ Mapl

| T Layers 52 S
@

- 0 cities :

[ [] Parks

[ [ ElevationBathymetry

| [P catalog 32 Search | Default Feature Editor | Progress View | gy ® ¥ =0

E HE wms: | feeennZ, dmsolutions, ca

=) r o) 1 ="
Renae Progress

WG5S 84 |—164.19 182.5? \ [Cities,Parks, Elevation/Bathymetry] B O

Figure 3 Render Processing Display

Tip: You can press on the button next to the progress monitor to watch detailed
information (and cancel) rendering requests.

XL
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9. When the layers are done rendering, the Map view will display the visible

layers.
= UDIG
File Edit Mavigation Laver Tools Analysis BUEGEEEE Help
= = r o & (= ] ' =
ol & | & |spgilemeal e ¢ | A-d-i0-1 -@&-
|2 Projects 53 7 = O | e =i |
-5 My Projects
-
P i = ﬁ e "
TE Layers i3 : | Iqalutt
| @
-[F * Cities
i Regina
b [ Parks o 5 ; ‘St. John's
i Elevation/Bathymetry Winnipeg
Toronto Hallfax.
@Catalog 53 Search;DeFauIt Feature Editor: Lxg S|
-4—,-- wms: | fuanZ, drsalutions.ca
WG5 B4 ||-124.38 |49.30

Figure 4 Rendered Layers
Now that you have some data on screen try playing with the following tools:
e Zoom Tool: (keyboard short cut Z)
e Pan Tool: (keyboard short cut P)

Tip:  When using the zoom tool the mouse scroll wheel can be used to quickly change scale.
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5) ADDING LAYERS FROM THE CATALOG VIEW

In this section you will learn how to add additional layers to your map from a
previously connected data source (the DM Solutions WMS).

Adding a Layer from a previously connected WMS:

1. In the Catalog view of uDig (center bottom), expand the connection you have
to wms:/ /www2.dmsolutions.ca. Right-click on the prov_bound layer and
select Add to Current Map.

Search | Default Feature Editor | Progress

=1-F0 wns: ez, dmsolutions ca
bathymetry

land_fn
park.
drain_fn
drainage

[F add to Mew Map E

¥ Add to Current Map

¥ rRemove

F2g Impart...,

Analysis 4

Figure 5 Add Layer to Map

2. The new layer will appear in the Layers view, and it will automatically start
to render. When it finishes rendering, you should black lines representing
the provincial borders on the map (the new layer).

% UDIG

File Edit MNavigation Layer Tools Analysis  Window Help

= - e AT P - =5 z
- |G | | E e w f | Q-1 -

| 2 projects 52 = =

= My Projects
= 15 projeck
[+ Map1

| T2 Layers 52| ]
1y Bry
~[& O Provincial Borders
[ O Cities

[E] O Parks
[ [0 Elevation/Bathymetry

*. e
:25--@ wims: w2 dmsolutions. ca ~
- bathymetry
= land_fn
= park.
= drain_fni
= drainage
- prov_baound e

E.(

[E Catalog &3 | Search | Default Feature Editor | Progress Yiew

WS B | -91,65 | 103.01

Figure 6 Viewing Multiple Layers
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6) ADDING A LAYER FROM PROJECTS VIEW

Adding a Layer from a PostGIS database:

1) In the File menu, select New -> New Map. Then in the Projects view, right-
click on Map2 and select Add... to bring up the Add Layer wizard.

¥ =0 |]Map1

=1- My Projects
=22 project

Open Project
o Layers 52 8 Delets Delste

Rename

Figure 7 Map Context Menu
1. Select PostGIS as the data source and click Next.

=2 Add Layers to Map @

Select a Data Source %

@?Files
Map Graphic
g IS
ﬁ\v\n‘eb Feature Server
@Web IMap Server

| Mext = | | Cancel |

Figure 8 Adding a Layer from PostGIS

2. Enter the following connection information:

55 Add Layers to Map @

PostGIS
Connect ko a PostEIS Server, ¥

Hosk: | wirwy, refractions net j Port: | 5432

Username: | postgres

Password: |

Database: |dem0—bc j
Schema: |public j
< Back | ek = | | Cancel |

Figure 9 Connecting to a PostGIS database

3. Once the connection information is entered, click on the database drop-

down. Select the demo-bc database and press Next.

@le.f rackens Walkthrough 1: uDig Install and Introduction



@ Ref

r
A

s,

4. Select only the bc_voting areas and the bc_hospitals data, then click

5.

Finish.

= Add Layers to Map @

Layer Selection 4n=
Seleck resources that the news map will be composed From, E

= n PostGIS wiww refractions, net. postgis. jdbc
[ bc_hospitals
[ bc_municipalicy
O & be_pubs
O & be_roads
O @ bec_voting_areas

| Einish |

Cancel |

Figure 10 Select Postgis Table

It may take a short while to fully render since you are zoomed out so far, but

your new map should look something like this:

|] Mapl I aﬂm

Figure 11 Viewing a second map

Walkthrough 1: uDig Install and Introduction
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7) WORKING WITH FILES

You can work directly with files from the file system:

1. Navigate to the included data directory.

2. Drag and Drop the file bc_2m_border.shp onto Map2.

ﬁ File Edit ‘View Favorites Tools  Help

Analy

%K@ Q

Window

Help

@Back = -\_.,)

(e

-

[ mMap1

l? /") Search ||: Folders

||]Map2 E@I

s

R

File and Folder Tasks

@ Renarme this FiE
@ Mov]’\\é;hi%ie %
%opy this file

& Publish this file to the
Wah

(5) E-mail this file
¥ Delete this fils

»

Other Places

i oo

u’__-] My Documents
Iy shared Documents
a My Cormputer

Figure 12 Drag and Drop File

B
':% be_haspitals. dbf
m be_hospitals.pri
bec_hospitals.shp
m be_hospitals.shx

: be_municipality, db

m bc_municipality. pr

= be_municipality. sh

fAddress ([ LR efractionsuDIG1.0,00daks
] be_border.dbf

|'_ﬂ be_baorder.pri
c_border.shp
we_border.shix

|ﬂ be_runicipality. sh

= be_pubs. e
m bec_pubs.pri

be_pubs.shp
m be_pubs. shx
: bc_roads. dbf

|'_ﬂ bc_roads.prj
=9 i

3. This provides a bit of context for your Postgis layers.

Ly Pefrastions,
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8) IMPORT DIRECTLY TO THE CATALOG

Earlier we learned how to work with previously used content from on the
Catalog view. Lets do that again:
1. On the Catalog View please press the Import button:

@Catalog i2 | Search | Default Feature Editor | Progress Yiew E2g ¥ =0

- [ postgis: s, refractions,net:5432 T
+] wms: | fewannZ, dmsolutions, ca
+] data\bc_border.shp

Figure 13 Catalog Import

2. Select Data and press Next.

Select
Y

Import from a data source. @ P

Select an import source;

o]

| Next = | | Cancel |

Figure 14 Import Data

(The next release will support Style and Context documents.)

3. Please choose Web Map Server from the list and press Next.

X
Select & Data Source ’g
E? Files

{4 Map Graphic
B PostGIS
ﬁWeh Feature Server

b Map Server

< Back. | Mexk = | | Cancel |

Figure 15 Import Web Map Server
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4. This time we are going to import the JPL World Map Service from the
following Capabilities document:

| http://wns.Jjpl.nasa.gov/wms.cgi?Service=WMS&Version=1.1.1l&Request=GetCapabilities

S. Press Finish to import the Web Map server.

% Catalog Import E

Web Map Server

Imports a Web Map Server inko the catalog \g

Enter a URL that points to a Web Map Server's GetCapabilities document:
| http: f fwms. jpl.nasa.gov/wms . cgi?Service=WMSENVersion=1.1. 1 BRequest=GetZapabilities j

< Back | | Einish | Cancel

Figure 16 Import JPL World Map Service

6. Now that we have imported the WMS into the catalog we can add it to our
Map. Please Drag and Drop the global mosaic layer directly onto Map2.

EEX

File Edit MNavigation Laver Tools Analysis Window Help

£~ @ | B EA w7 | Q-0 -1 -
|2 Projects 52 = = 8| @ Map1 [d mapz i S|
=15 My Projects
=112# project
[+-[d Map1
[+-[d Map2
]
=

T Layers 52 |
A
/4 be_border

[ # be_municipality
i B bc_hospitals

by

atalog X SearctheFﬁ\l{@eature Editor | Progress Yiew | m ® =0

e
| wms: ,l',l'wms.jpl. nas&%ﬂ% -

@
= global_mosaic ‘base

- us_landsat_wgs34
- us_overlays

- usA0_overlays

- daily_terra

WG 84 |[-131.27 151.9- |

Now that the global mosaic layer is rendered on top of your existing content lets
proceed to the next section on reordering layers.

|£
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9) REORDERING LAYERS

In this section you will learn how to reorder layers in your map.

1. At the end of the previous section we left Map2 in the following state:
=8

|
wWM5 Global Mosaic, pan she
M be_border
M b _muricipality
B be_hospitals

Figure 17 Layers View

The Layers view is used to describe the content of the map, and the order
in which the content is drawn.

2. To change the layer order, select the WMS Global Mosaic, pan sharpened
layer and press the Down arrow.

e selected laver down [§
o

: [ @ be_municipality
[# ® bc_hospitals

Figure 18 Layer Down Button

3. You can also just select a Layer and Drag it to the position you desire. Lets
do that now, Drag and Drop the WMS Global Mosaic, pan sharpened layer

to the bottom of the list.
e x ]

A
1 be_border

WMS Global Mosaic, pan,she
[ # be_municipalicy

B be_hospitals [ %Lk

Figure 19 Drag and Drop Layer Order

Moving layers up and down will change their visibility in relation to each other,
and it will automatically restart rendering the map.

@ Refractions Walkthrough 1: uDig Install and Introduction -18-
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10) THEMED DATA

Some files come with “Style Layer Descriptor” (or SLD) documents describing how

they should be rendered. Lets work with one:

1. In the Layer menu, select Add...

2. Choose Files from the provided list and press Next:

= Add|Layers to Map @

Select a Data Source

[ Map Graphic
U posters

‘WWeb Feature Server

@Web Map Server

| Mexk = | |

Cancel

Figure 20 Add File

3. Select the file countries.shp from the data directory and Open:

4. The countries layer will be added, and rendered with labels as outlined in the
file countries.sld

Tip:

Open @
Look in: | | data _v_| = & B~
- 1 @ be_barder.shp
\_*.:3 be_hospitals.shp
My Recent @ be_rnunicipality. shp
Documents hcpubs.shp
@ be_roads.shp
bc_woting_areas.shp
Desktap cities.shp
- E'_] clouds.jpg
-
My Docurments Llj earthights.jpg
@ nevyork_census.shp
- timezone.shp
!ii—j‘! usa_counties.shp
ky Cannputer
M_'r':;%ﬂrk File name: |countlies.shp lJ Open |
Flaces
Files of type: |"_ghp;"_gi[;", ipa;”ipeg; . prg _vJ Cancel

Figure 21 Open Countries.shp

try it out. You may have to refresh afterwards.

@ Ref rla!_rlti'l:bp,tsL
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11) SEARCHING AND INFORMATION

In this section, you will learn how to use the Search View.

1. Select the Search View.

2. Insert the cursor into the text box and type “bird”. Press enter.

Catalog Default Feature Editor

v o H

Search String: | birds

™ within Viewport

+-- [ CBC_PY
- [ MMP
MMP
BBS_PT
CBC_PT

&

IEA

][

W

Studies Canada and Mature Canada.
2004, Important Bird Areas of Canada
Database. PortRowan, Ontario: Bird
Studies Canada. To access the Canadian
IBA directory:

http: fjwww.bsc-eoc.orgjiba fibasites. html
tadata for this layer:

http: ffwww. bsc-eoc.orgfwebsite/metadat
ajcaniba_paly.xml

o

154l

Figure 22 Search View

3. Once the entries appear right-click on Canadian Important Bird Areas

and select Add To New Map.

4. For context, drag the countries shape file in from your catalog and use it

as a backdrop.

All sorts of interesting content is available on the web.

What can you find?

@le.f rackens Walkthrough 1: uDig Install and Introduction
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12) INFORMATION REQUEST

Tip:

@ lielf rac "W;

In this section, you will learn how to use the Information Tool.

1. To start with lets open up Map1 again.

—-1zZ#& project |
+ EW

Open
Open Project

8 Delete Delete

2. Lets Zoom into someplace interesting, like a park.
dRLaAw s @A-d-00-1-%-

P Mapl X =08

&£
3. Select the Info Tool from the toolbar, and click on a nice green park
PRI » g |Q &

=0

P Mapi X

: St ]ohn.-s
& Cé""‘@

You can use the keyboard short-cut i’ to choose the info tool

4. Note how the Information View is brought into focus.

5. Select the layer name Parks in the left pane of the Information View.
Information regarding the area you clicked is displayed in the right pane.

Catalog | Search | Default Feature Editor SIS a=nT S ¥ =08

Name Year Est. Area (sq.kkm)
Gros Morne National Park 1970 1942 500

€ DM Solutions Group

Not all Web Map Servers support the “GetFeaturelnfo” operation; as such
information may not be available for all layers. The application uses a normal
browser to display HTML content, you can drag the view out of the workbench if
you find you need more elbowroom.
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13) FINISHED ALREADY?

If you finish early here are some challenges.

There is more data available in the data directory- have a look

Try right clicking on a Layer — there is plenty to do (starting with styling).
Have a search for information in your area?

Is content you have published available via search?

Try out the navigation tools such as Zoom and Pan (the Navigation menu lets
you go back to previous locations like a web browser).

Advanced: Have a look at the countries.sld file and see what you make of it?

Perhaps you have an idea for the tool you always wanted?

L efasions,
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